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Disclaimer.

The material contained within this document is classified information. Reproduction,
adaptation, or translation without prior written permission is prohibited, except as
allowed under the copyright laws.

The information contained in this document is subject to change without notice.
Austec Systems Pty Ltd makes no warranty of any kind with regard to this material,
including, but not limited to, the implied warranties or merchantability and fitness for a

particular purpose.

Austec Systems Pty Ltd shall not be liable for errors contained herein or for incidental
or consequential damages in connection with the furnishing, performance, or use of
this material.
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1. GETTING STARTED

Welcome to the MRP 70 - 1000C programming software for the following radios;
Midland Z-273 Mobile,
AWA RT 85 Mobile.

This package contains the following parts.

¢« MRP 70 - 1000C EPROM programming- unit

s 3% inch floppy disk - IBM PC compatible format

« MRP 70 - 1000C User Manual

if any of these parts are missing, please contact your Dealer.

1.1 System Requirements

In order to use the MRP 70 - 1000C software, the following minimum computer
hardware and software is required.

« IBM PC or Compatible Computer

3% inch tioppy disk drive

Hard Disk

1 MB RAM

Serial Cable

Mouse (optional)

« Printer (optional)

A mouse and printer are optional, but to gain fuil ease of use, we suggest you have
both. :

1.2 Before You Begin
Before you can install MRP 70 - 1000C, you must have DOS 3.3 or later installed on
your computer. For instructions on instailing DOS on your computer, consult your
computers documentation,
The release diskette contains the following files:

MRP70.EXE MRPHELP.HLP

README.TXT SAMPLE.DAT
if these files are not present on the diskette, or the diskelte is defective, please
contact your Dealer.
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1.3 Installing MRP 70 - 1000C

It is highly recommended that you make a backup of the release diskette before
installing the MRP 70 - 1000C software on your system.

Although the MRP 70 - 1000C software will run from your floppy drive, we recommend
that you install the MRP 70 - 1000C software on your hard drive.

To install the MRP 70 - 1000C software on your hard disk, put the MRP 70 - 1000C
software release diskette in drive A: or B: of your computer.

+ Make a directory called MRP on your hard drive.
+ Copy all the files on the distribution disk to this directory.

For example, to install the MRP 70 - 1000C sofiware on the C: drive of a hard disk
with the release diskette in drive A:, you would type the following:

MD CAMRP
COPY AN.* CAMRP

Once the MRP 70 - 1000C software has been installed, the hardware must be
connected to your computer. The MRP 70 - 1000C has been configured as a DCE
(Data Communication Equipment) device and can be connected to the PC (DTE
device) using a standard Modem/Serial cabie available from computer suppliers.

Connect the Serial Cable to COM 1: (COM 2: if mouse is on COM 1) on your
computer and also to the MRP 70 - 1000C unit. Connect a +12V DC power supply via
a 2.1mm Jack Plug to the MRP 70 - 1000C unit. Note that the cenire pin of the
socket is positive.
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2. AQUICK TOUR OF THE MRP 70 - 1000C

This section intrcduces the fundamentals of using the MRP 70 - 1000C software. To
start the MRP 70 - 1000C software, change directory to the one containing the MRP
70 - 1000C software. Type MRP70.EXE to start the program. To exit MRP 70 -
1000C, choose File | Exit or press Alt X.

2.1 The MRP 70 - 1000C screen

When starting the MRP 70 - 1000C software program, the following screen is
displayed.

Figure 1. The Opening Screen.

Figure 1 shows a Message Box that gives information about the program including its
Version.

On all Message Boxes that appear, there are a number of ways in which the Box can

be closed.

» Use the mouse and click on the OK button

» Use the mouse and click on the close box in the upper left corner

« Press Enter to accept the currently highlighted command (in this case its the OK
button)

* Press Alt O to select the OK option button

s Press ESC to exit the box and tose any saved data {if any)

Figure 2 shows the layout of the MRP 70 - 1000C screen. Across the top of the
screen are a number of Menu Bar options. These can be selected either by the
mouse clicking on the desired menu item and dragging the pointer down, by pressing
ALT and the letter highlighted in each menu item or, finally, by pressing F10 1o move
to the Menu Bar and pressing ENTER when the desired menu item is highlighted.

=}
[+ 53
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Current EPRGM Type Today's Date & Time

Menu Bar

Fite T " T

Changed Current File Open

Figure 2. MRP 70 - 1000C Screen Layout.

The Menu Bar ltems are :

= System Menu which is used to change Com Port, Colours and Mouse Cptions.
FILE Menu is used to create, load, save or print files. It also allows the user 1o
shell out to DGS and Exit the program.

EPROM Menu contains different options for the EPROM, such as Reading and
Writing. It also is used to perform Manual Edit on a file.

CHANNELS Menu is used to change the Band and Modifier code for the EPROM.
It also allows the user to enter a Centre Frequency (if available).

OPTIONS Menu allows the user to change such options as Heading Data, BCLO,
Scan Hold RX/TX and Scan Mode.

Next to the Menu Bar is the EPROM Type. This displays what the current EPROM
Type is. Finally, the current Date and Time are displayed.

Along the bottom of the screen is the Status Line. This shows which “Hol Keys" are
available. A Hot Key is a key that when pressed will jump straight to the action
specified. The Hot Keys available are

F1 Help - This is a comprehensive on-line help facility available to the user at any
time within the program. |t lists current actions available as well as the values that
can be entered.

F2 Save - This will save the current file name, as stated in the bottom right corner,
or ask the user for a name to save the file as if a file has not yet been opened.

F3 Load - This will bring up a Box asking the user to specify the file they wish to
load. If the current file has changed, then they are first prompted if they wish to
save that data.

F6 Next - This changes the currently setected window. It cycles through all five
windows in the order they were chosen.

F10 Menu - This moves the highlight to the Menu Bar and allows the user to select
one of the Menu Bar items.

ALT-X Exit - This will exit the program. If the current data has been changed then
the user is prompted to save the file first.
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Next to the Status Line is the File Changed Flag. When this flag is shown (as a *),
then the data on the screen has been changed (changing Band does not effect this

flag when first starting). When loading a new file from disk or EPROM, or when
selecting FilelNew or Exiting the program, the File Changed Flag is checked. If
activated, then the user is asked to save the current file before continuing.

Finally along the bottom line, the current file is displayed. This shows the name of the
file and the path to it.

Between the top Menu Bar and the bottom Status Line, there are a number of
windows. These windows are used to enter the Data that is to be programmed into
the EPROM. The five windows are

OPTIONS - allows the user to change such options as Heading Data, BCLO, Scan
Hold RX/TX and Scan Mode.

CHANNELS - is used to change the Band and Modifier code for the EPROM. |t
also allows the user to enter a Centre Frequency (it available).

PROGRAM CHANNELS - is used to enter the RX and TX frequencies for use in
the Radio. Also, RX and TX Auxiliary values can be entered.

SCAN A - allows the input of channels already programmed to be entered. These
are independently activated by corresponding scan pushbuttons on the transceiver.
SCAN B - allows the input of channels already programmed to be entered. These
are independently activated by corresponding scan pushbuttons on the transceiver.

The currently active window is shown by the double line around the border of the
window. In Figure 3, the CHANNELS window is the currently active window.

Within the window, there may be a number of options (such as Band, Modifier and
Center Frequency in the CHANNELS window). The option that is highlighted (in
Figure 3 case it is Band) is the current item. Pressing ENTER wili select that item and
perform the action that it specifies.

Current Windew

Figure 3. Current Window and ltem

pg 2-3
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To mave the highlight to the next item, press the T arrow key to move up, or the 4
arrow key to move down. To move to any item in the current window, press ALT and
the letter in the item name that is highlighted.

The mouse can also be used to select an item by clicking once on the items name,
To perform the action of an item, double click the mouse on the items name.

To move between windows, press the Hot Key F6 (shown as Next in the Status Line).
This will select the next window and allow the user to enter and change data in that
window. Any window can be selected by using the mouse. To select a window with
the mouse, just click once anywhere in the desired window. That window will then
become the current window.

pg 24
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3. MENU DESCRIPTION.

This section gives a description of the Menu Bar Items and the Window contents and
how to edit data in all areas.

3.1 =System Menu
Figure 4 shows the different options available in the System Menu.

Figure 4. System Menu ltem selected.

The System Menu contains the following options

* Mouse - which is used to change certain parameters involving the mouse such as
double click speed.

¢ Colours - allows the user to change the colours on the screen.

+ Com Port - allows the user to specify which Com Port the MRP 70 - 1000C
hardware is connected 0.

« About - this shows information about this release of the MRP 70 - 1000C software.

3.1.1 Mouse.
When the Mouse item is selected, Figure 5 appears.

. The Double click speed sets the delay between recognising mouse clicks. The faster

the speed set, the faster the user must double click the mouse buttons in order to be
recognised.

pe 3-1
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Figure 5. Mouse Options Dialog Box.

To change this setting, select the ‘Mouse double click' option and then either

« press the left (<) arrow to move the seiector to the leit (Faster) or the right (—)
arrow to move the selector to the right (slower).

+ use the mouse to move the selector by pressing on the left arrow on the screen {<)
or the right arrow on the screen () or click on the selector with the mouse and
while holding the mouse button down, move the selector left or right.

The “Reverse mouse buttons” option is used to change which button on the mouse is
used. The default value is the left button. For some users, such as left handers,
selecting this option would make the right button active. To select this option, select
the “Reverse mouse buttons” option and then press the space bar to select. A cross
appears in the box to show it has been selected.

3.1.2 Colours
When the Colours item is selected, the following Box appears.

Figure 6. Colours Item Dialog Box.

The Colours Dialog Box is split into a number of areas. Firstis the Group area. This

contains three options

+ Desktop - set the colour of the Desktop. The Desktop is not visible most of the
lime as the windows cover all the screen.

e« Menus - sets the colours of the Menu Bar and the Status bar. This includes the
text, background, highlighted and short cut colours.

pg3-2
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« Dialog/Calc - is used to set the colours for the windows inciuding windows,
background, borders, lists, scroll bars, buttons, highlighted and short cuts keys.

To select the option, move the arrow keys up (T)or down (1) or click on the option with

the mouse.

Once a group is selected, the item the user wishes to change needs to be selected.
Press TAB to change to the next window, or Alt or click on that window with the
mouse. As stated before, the ltems window contains a number of options such as
text, lists, scroll bars, highlighted, short cuts etc. To select the opticn, move the arrow
keys up {Nor down () or click on the option with the mouse, As the user moves up
and down the opticns, the current colour setting for that opticn is displayed where the
six words of “Text” are shown.,

To now change the colour of an item, press TAB to change to the next window, or Alt
I or click on that window with the mouse. The user can now select which foreground
and background colour they wish to use. When finished, press ENTER, Alt O or click
on OK to save the change, or press ESC, Alt C or click on the CANCEL button or the
button on the top left corner of the window. If the data is saved, the changes are
made immediately to the display.

3.1.3 Com Port
When the Com Port item is selected, the following Box appears.

Figure 7. Com Port Dialog Box.

This Dialog box is used to change the Com Port on which the MRP 70 - 1000C
hardware is attached. The default value is Com Port 1. To change the current
setting, use the arrow key to move up (T) or down ({) to the desired Com Port. When
the correct Com Port is selected, press the space bar to select it. When finished,
press ENTER, Alt O or click on OK to save the change, or press ESC, Alt C or click
on the CANCEL button or the button on the top left corner of the window. The data is
now written to the disk. Next time MRP 70 - 1000C is started, the new Com Port is
set as default.

3.1.4 About

The About box is used 1o display the current software version and other additional
data. See Figure 1 for more information on the About Box.

3.2 File Menu
Figure 8 shows the options in the File Menu ftem.



ME 70 - TYUUL User Manual Version 1.0

27 199471955

Figure 8. File Menu item selections.

The File Menu contains the following options

+ New - resels all data to default values.

+ Open - Loads a file frem disk.

» Save - saves a currently opened file.

s Save As - saves a file as a name requested by the user.
+ Print - Prints out the data from a file.

s Hex Print - A Hex dump of a file to the printer.

» DOS Shell - Shelis out to the DOS operating system.

« Exit - Quits the MRP 70 - 1000C program.

3.2.1 New

When the New ltem is selected, the File Changed flag is checked. If it has been set,
then data has been changed. A message Box will appear (Figure 9) telling the user
that they will lose current data and if they should continue. [f the user answers No
then no change is made. i the answer is Yes then ail data is ignored.

Figure 9. Lose Current Data Warning Box.

When selected and the user has ignored any changes, or there have been none, then
all the data is reset to the default values. This means that all channels programmed,
all scan data entered and any options (inctuding Heading Data) are reset. The Band
is set to 50mhz and no Modifier is used. The Filename and File Changed flag are
also cleared

a3-4
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3.2.2 Open-F3

Open is used to load a file from the disk. The Open command can also be selected
by pressing the hot key F3. When Open is selecled, the following screen is displayed.

Figure 10. Open a File Dialog Box.

The “Open a File" Dialog box comprises of two main sections. The first section is
“Name” where the name of the file to load is entered. When opening this box, a list of
files in the current directory is shown in the section “Files”. All files used to save and
load Data use a “.DAT" extension.

To select a file from the “Files” list, press TAB or Alt F or click on the window. Use
the up (T) or down (1) arrow keys to move up the file list. Details about the current file
is shown in the bottom part of the window. This information includes the File's Path,
Name, Size and last modified date. When the file you wish to load is found, press
ENTER, Alt O or click on the name with the mouse. If the data file you require is in
another directory, then select the directory and continue to look for the file.

When the file is opened, the current EPROM type changes to refiect the type in the
fite, and the name of the file is displayed at the bottom left of the screen. The
windows are also updated to show the data loaded.

3.2.3 Save-F2

The Save item is used to save the data entered by the user to a file which can be
used later. This command can alsc be cailed by pressing the Hot-Key £2. When the
Save command is selected, the program checks to see if a file has been opened. lf

. the user is working on a file that has been opened, then this data is saved to disk. If
there is no file open, then the Save As command is executed.

3.2.4 Save As
The Save As item is used to save a file as a user defined name.
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Figure 11, Save As Dialog Box.

If the user presses F2 or selects Save {from above) and nc file has been loaded, then
this item is called. The window disptayed when this is called is shown in Figure 11.
As can be seen, this window is similar to the Open Window. All the same functions
from Open are valid here. The only difference here is that instead of opening a file, it
saves it.

3.2.5 Print
This item is used to print out the details of a file to the printer.

Qyyg 38,1994 172

Figure 12. Print a File Dialog Box.

This Dialog box is similar to the Open and Save As Dialog Boxes. When a file is
selected for printing, the data from the file is loaded and the printer is checked to if it
is ready to print. If the printer is not ready then the following screen message
displayed.

pg 3-6
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Figure 13. Printer Error.

Another error that can occur is if the printer is out of paper or the printer is off line. If
this is the case then the a Box similar to Figure 13 is shown except the error is the
Printer is out of Paper,

Sample printouts are shown in Appendix B.

3.2.6 Hex Print

This item is used to print out the details of a file in hex format to the printer.
The same screen is used as Figure 12. The same error messages as above are
applicable to Hex Prints. Sample printouts in Hex form are shawn in Appendix B.

3.2.7 DOS Sheli

This command is used to shell out to the DOS prompt. There, a user can perform
such actions as directory listings, copy files, etc. To return to the MRP 70 - 1000C
software, type EXIT.

3.2.8 Exit- AitX

To exit the program, the user selects this option. When the program tries to exit, it
checks the File Changed flag to see if any changes to the current file have been
made. If this flag Is present, then Figure 14 is displayed asking the user if they wish
to continue. If they select NO then all changes are lost and the program closes, if
they choose YES then the file is saved and the program closes otherwise program
does not close and the data is not lost.

Figure 14. Warning when Exiting the Program.

3.3 EPROM Menu
Figure 15 shows the options in the File Menu item.

pa 3-7
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The EPRCM Menu ltem contains the following opticns
+ Type - selects the type of EPROM to be used.
+ Blank - Does a blank check of the EPROM.
¢ Program - Program the data from a file to the EPROM.
* Auto (B & P) - Perform a Blank Check and then Programs the EPROM.
« Read - Read the data from an EPROM and save it in a file.
¢ Version Info - Get the Version info from the MRP 70 - 1000C unit.
« Manual Edit - Edit the Hex data of the loaded file.
7 OpE FATand Hahils

Figure 15. EPROM Menu item selection.

Warning: The MRP 70 - 1000C programming unit must be switched off before an
EPROM is connected or removed from the unit.

3.3.1 Type
When Type is selected from the EPROM menu, the following screen is displayed.

Figure 16. Different EPROM Types.

This Dialog box lists the different EPROM’s that are available, which are
« Midland Mobile - Displayed as the Z-273 Mobile.
« AWA Mobile - Displayed as the RT-85 Mobile.

Each of these radio EPROM'’s has different options available, which are described in
later sections.
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3.3.2 Blank
The Blank function is used lo perform a Blank check of the EPROM. The following
screen is displayed.

Figure 17. Blank Test.

This checks the EPROM in the MRP 70 - 1000C hardware unit to see if it is
completely Blank. if it the software does not get a response then Figure 18 is

displayed.

Figure 18. Unable to Communicate to the hardware.

In this case, check the hardware setup of the MRP 70 - 1000C unit and try again. |f
there is stitl no response, try changing the Com Part {(as described in section 3.1.3

and try again.

if communications are successful, then there are two possible responses. The first
one is if the Blank check is successful. If this is the case then Figure 19 is displayed.
The EPROM can now be programmed with the user's data.

Figure 19. Blank Check Pass.

If the Blank Check is unsuccesstul, the message in Figure 20 is displayed. The
message contains the first byte in the EPROM that is not Blank. In this case the
EPROM must be inserted under an Ultra Violet light and erased.
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Figure 20. Blank Check Fails on Byte 0x01.

3.3.3 Program

This option is selected when the user wishes to program an EPROM with data they
have saved 1o a file. If the data the user is currently working on has changed when
they select this option, then the following Dialog Box is displayed. This allows the
user to save their current data before continuing.

Figure 21. Program EPROM Warning Dialog Box.

The user is then asked to select which file they wish 1c use to program the EPROM.
The screen that is displayed is similar to the FilelOpen screen shown in Figure 10.

Once a file has been detected and loaded, Programming takes place. The screen
that is displayed is shown in Figure 22.

Figure 22. Programming the EPROM.

~ The same error condition apply as with a Blank check. That is, if there is no response
from the MRP 70 - 1000C hardware unit then Figure 18 is displayed. if the
Programming was successful then Figure 23 is shown. Otherwise, Programming
faited and the EPROM may need to be erased before trying to Program again.

pg 3-10



MRP 70 - i000C User Manual Version 1.0

Figure 23. Programming EPROM successful.

3.3.4 Auto

The Auto option is a combination of the Blank check and the Programming. First, a
Blank check is performed (see Section 3.3.2). If this passes then Programming takes
place (see Section 3.3.3). All the same error conditions apply.

3.3.5 Read

The Read command is used to read the contents of an EPROM and store the result in
a file, which is then loaded automatically. When selecting Read, the File Changed
flag is first checked. If this flag is present, then Figure 9 is displayed.

Figure 24. Save EPROM Read Data.

Before the actual Read can take place, the user must specify the name of the file to
save the data to, as shown in Figure 24. This has the same format as the Save As
screen from section 3.2.4.

Once a file name has been specified, the EPROM is read. The following figure
displays this action.
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Figure 25. EPROM Read in Action.

The same error condition apply as with a Blank check. That is, if there is no response
from the MRP 70 - 1000C hardware unit then Figure 18 is displayed. If the Read was
successful then the MRP 70 - 1000C screen is automatically updated with the new
data.

3.3.6 Version Info

The Version Info option is used to find the Version Number of the firmware on the
MRP 70 - 1000C hardware unit. An EPROM is not required for this option. The
tollowing figure is displayed when this opticn is called.

Figure 26. Find Version Info from Hardware.

The same error condition apply as with a Blank check. That is, if there is no response
from the MRP 70 - 1000C hardware unit then Figure 18 is displayed. If the Version
Info was successful then Figure 27 is shown.

Figure 27. Hardware Firmware Version Number.

3.3.7 Manual Edit

This item is used to select the manual edit function. To use the manual edit, a fite
must be loaded and must not have any data changed. This can be checked by
looking at the File Changed Flag at the bottom of the screen. If a file is not loaded or
the file has been changed since it was loaded, then a message box will be displayed
showing this fact.

The screen presented to the user contains a list of addresses relating to the memory
map of the EPROM. The current settings are shown in the list while the currently
selected value is highlighted. See the figure below.
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Figure 28. Manual Edit Screen.

There are several ways to move around the screen and edit values.

e & & o

Pressing Home moves the cursor to the top left corner.

Pressing End moves the cursor to the bottom right corner.
Pressing Page Down brings up the next page of Addresses.
Pressing Page Up brings up the previous page of Addresses.
Pressing arrow keys move you around the screen.

Pressing Tab moves you to the options at the bottom of the screen.
Use the mouse to change pages.

To edit the data, the user can

Press enter at the current position. A Dialog box appears that shows the current
setting and allows the user to enter a new setting.

Double click on the memory focation to edit. A Dialog box appears that shows the
current setting and allows the user to enter a new setting.

Just typing in the new value at the current position will change the data.

3.4 CHANNELS Menu
Figure 29 shows the options in the Channels Menu Item.
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Figure 29. CHANNELS Menu Item selection.

The CHANNELS Menu Item contains the following options

+ Band - To select the band in which the radio operates in.

+ Modifier Code - Associated with the Band selection.

+ Center Frequency - Set if appropriate Band and Modifier Code Selected.

3.4.1 Band
When selecting the Band option, the following screen is displayed.

Figure 30. Band Dialog Box.

To prepare the Midland radio for channel frequency programming, a band selection
code musl be entered from the following table.
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Band Modifier | Bandwidth | RX-IF TX-IF REF Local
Code Code MHz MHz MHz KHz Injection
0 - 25-55 10.7 10.24 5.0 High
0 A 25-55 10.7 10.24 5.0 Low
0 B 25-55 10.7 9.6 12.5 High
0 C 25-55 10.7 9.6 12.5 Low
0 D 25-55 10.7 10.24 2.5 High
0 E 25-55 10.7 10.24 2.5 Low
1 - 60-90 214 20.48 5.0 High
1 A 60-90 21.4 20.48 5.0 Low
1 B 60-90 21.4 19.2 12.5 High
1 C 60-90 214 19.2 12.5 Low
1 D 60-90 21.4 20.48 2.5 High
1 E 60-90 21.4 20.48 2.5 Low
2 - 136-174 21.4 2048 |50 Low o
2 A 136-174 21.4 20.48 5.0 High
2 B 136-174 21.4 19.2 12.5 Low
2 C 136-174 21.4 19.2 12.5 High
2 D 136-174 21.4 20.48 2.5 Low
2 E 136-174 21.4 20.48 2.5 High
3 - 403-520 21.4 18.2 12.5 Low
3 A 403-520 21.4 19.2 1256 High
3 B 403-520 21.4 20.48 10.0 Low
3 C 403-520 21.4 20.48 10.0 High
3 D 403-520 21.4 20.48 5.0 Low
3 E 403-520 21.4 20.48 5.0 High
4 - 806-866 47.0 19.2 12.5 Low
4 A 806-866 47.0 19.2 12.5 High

Figure 31. Band Selection Tabie.

The current settings for the Band is shown in the CHANNELS window of the MRP 70 -
1000C software, as can be seen in Figure 29.

3.4.2 Moditier
When selecting the Modifier option, the following screen is displayed.
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Figure 32. Modifier Dialog Box.

Modifier Codes must not be used unless the corresponding component or kit changes
have been made to the radio. The available modifier codes and their effects on each
Band is shown in Figure 32 above.

The current settings for the Modifier Code is shown in the CHANNELS window of the
MRP 70 - 1000C software, as can be seen in Figure 29.

3.4.3 Center Frequency

The Center Frequency can only be set when the Band has been set to Band Code 2
(136 - 174 MHz range) and there is a Modifier Code set. If this is not the case, then
the user is unable to select this option.

The screen that is displayed is

Figure 33. Center Frequency Dialog Box.

Depending on the Modifier selected, different Center Frequencies can be selected.
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Band & Radio Band RX Frequency TX Frequency
Modifier

15A A Band 146.980 MHz 147.150 MHz
15A B Band 159.670 MHz 160.500 MHz
158 A Band 147.000 MHz 147.000 MHz
158 B Band 160.600 MHz 160.000 MHz
15C A Band 147.000 MHz 147.000 MHz
15C B Band 160.000 MHz 160.000 MHz
15D A Band 148.120 MHz 147.200 MHz
15D B Band 160.920 MHz 160.000 MHz
15E A Band 146.920 MHz 147.840 MHz
15E B Band 159.720 MHz 160.640 MHz

Figure 34. Center Frequency Data Table.

The current settings for the Modifier Code is shown in the CHANNELS window of the

MRP 70 - 1000C software, as can be seen in Figure 29.

3.5 OPTIONS Menu
Figure 35 shows the options in the Options Menu ltem.

Figure 35. OPTIONS Menu item selection.

- The CPTIONS Menu ltem contains the following options

s Functions Codes 1 - Used to set the BCLO, TX Time Qut Timer, interval A.& B and

Scan Hold Timer,

e Function Codes 2 - Used to set the Priority Monitor and Scan Mode.
+ Heading Input - Sels the Model Number, Serial Number, Customer Number and

Date.

pg 3-17




MEP 70 - 1000C User Manual Version 1.0

3.5.1 Function Codes 1
When this item is selected, the following screen is displayed.

Figure 36. Function Codes 1 Dialog Box.

When first starting the MRP 70 - 1000C software, the current settings are set at their
default values. Selecting a different setting for an option moves the highlight to the
new setting. Only one setting can be selected for each option. The settings for
Function Codes are displayed in the OPTIONS window at the top right of the MRP 70
- 1000C software screen.

Busy Channel Lockout. (BCLO)

The BCLO function, if programmed, inhibits the transmitter if the selected channel is
busy. 1f BCLO with alert is selected, the operator will be warned by an audio beep
when transmission is inhibited. The BCLO function can be jumper selected in the
transceiver to operate (if programmed) on the presence of either CTCSS/CDCSS
signal or carrier.

TX Time Out Timer. (TOT)

The TOT function, if programmed, automatically shuts off the transmitter and gives an
audio beep when the programmed period of continues transmission has occurred.
This tunction prevents repeater hangup or transmitter overheating if the transmitter is
accidentally locked on.

Interval A.

Interval A, programmable for 12.5 {(Handheld only), 25, 50, 75 or 100 msecs, is a time
allocated for noise squelch operation while the scan is stopped on each scan
channel. At the end of Interval A, based on the noise squelch output status, either
causes the scan sequence to resume or activates Interval B (if CTCSS/CDCSS scan
is programmed). For all mobiles, interval A should be 25 msecs, the default
condition. For all Handheld's, Interval A shouid be programmed for 12.5 msecs
optimum scanning speed. Programming longer periods for interval A will cause
unnecessary delays in the scan sequence and result in slower scan operalion.

Interval B.
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Interval B is programmabie for 100, 200, 300 or 400 msecs and is the time period

allocated for operation of the CTCSS, CDCSS or other signalting systems during the

scan stop period on each channel. Interval B is activated following Interval A in the

scan stop period only if two conditions are met: ‘

» The noise squelch must be open at the end of Interval A, indicating a busy
channe! condition.

* A non-zero Auxiliary code must be programmed on the channel being scanned
{see Scan Mode section ).

If either condition is not mel, the scan sequence resumes immediately. All mobiles

and Handheld's using CTCSS or CDCSS scan should be programmed for an Interval

B of 300 msecs, the default condition. Longer Interval B periods will result in slower

scan operation and shorter perieds may cause impreper CTCSS/CDCSS decoder

operation.

Scan Hold Timer (after squelch close).

The Scan Hod Timer introduces a delay before resuming scan after the channel
becomes clear. This is programmable for 0.3, 2.5, 5.0 seconds or and infinite time
period. The choice of delay is highly dependant upon user preference and system
requirements.

Scan Hold Timer (after PTT).

After completing a transmission, a second Scan Hold Timer delays scan resumption
to allow reception of a reply. A programmable choice of 0.3, 2.5, 5.0 seconds or an
infinite delay is available, with a default of 5 seconds.
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3.5.2 Function Codes 2.
When this item is selected, the following screen is displayed.

Figure 37. Function Codes 2 Dialog Box.

When first starting the MRP 70 - 1000C software, the current settings are set at their
default values. Selecting a different setting for an option moves the highlight to the
new setting. Only one setting can be selected for each option. The settings for
Function Codes are displayed in the OPTIONS window at the top right of the MRP 70
- 1000C software screen.

Scan Mode,

Three separate maodes of scan operation labelled “Normal”, "Modified” and
“Secondary” are available for selection by function code. The features of the selected
mode are activated by two scan push buttons PRI and SCAN located on the
transceiver front panel or centrol head. In addition to selecting cne of the 3 scan
modes, a selection between Noise Squelch and CTCSS/CDCSS scan type must be
made. The final variable to be selected is between scan stop on a busy or open
channel.

Priority Monitor.

Priority Channel monitoring is available in each of the three scan modes defined in
Scan Mode above. This function can be deleted or programmed for frequency of
occurrence by appropriate code entry. Programming “No Function” means that in all
instances where Priority Channel monitoring is mentioned in the Scan Mode
description above, this function will not occur. If Priority Channe! monitoring is
desired as described above, the sampling rate during scan (once every four or eight
non-pricrity channels) and during scan hold on a nen-priority channel (once every
secend or every 2 seconds) must be pregrammed. The default condition causes
priority channel sampling after every eight channel during scan and once every
second during scan hold. :

3.5.3 Heading Input
This item is used to enter data about the radio's user.
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Figure 38. Heading Dialog Box.

This includes data on :

« Model Number (upto 4 characters),
Serial Number (upto 8 characters),
Customer Number 1 {(upto 3 characters),
Customer Number 2 (upto 7 characters),
Date (dd-mm-yy).

The Model Number, Serial Number and Customer Number 1&2 can be any character
in the range 0-9 and/or A-F. When the data has been set to its default values, the
current date is inserted in the date field. This date can be ¢changed to any other date
required.
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4. WINDOW DESCRIPTION.

The MRP 70 - 1000C screen is split into five windows. They are

« Channels - displays and allows the user to change the current Band, Modifier Code
and Center frequency.

+ Program Channels - displays and allows the user to change the RX and TX
frequency as well as the RX and TX Auxiliary vaiues.

s Scan A - displays and allows the user to set the scan channels for group A

s Scan B - displays and allows the user to set the scan channeis for group B

+ Options - shows the current settings for Heading, Function 1 and 2 Codes and
allows the user to change them.

The currently active window is shown by the double line around the border of the
window. In Figure 3, the CHANNELS window is the currently active window.

Within the window, there may be a number of options (such as Band, Mcdifier and
Center Frequency in the CHANNELS window). The option that is highlighted (in
Figure 3 case it is Band) is the current item. Pressing ENTER will select that item and
perform the action that it specifies.

4.1 Channels Window
The following shows the Channels Window.

Figure 39. Channels Window.

The Channels window contains the following options.

» Band - Te select the band in which the radio operates in.

s Modifier Code - Associaled with the Band selection.

s Center Frequency - Set if appropriate Band and Modifier Code Selected.

" These functions have already been covered in Section 3.4, Please refer to that
Section for details. :

4.2 Options Window
The following shows the Options Window.
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Figure 40. Options Window.

The OPTIONS Window contains the following options

¢ Functions Codes 1 - Used to set the BCLO, TX Time Out Timer, Interval A & B and
Scan Hold Timer.

+ Function Codes 2 - Used to set the Priority Monitor and Scan Mode.

+ Heading Input - Sets the Model Number, Serial Number, Customer Number and
Date.

These functions have already been covered in Section 3.5. Please refer to that
Section for details.

4.3 Program Channels Window

Figure 41. Program Channels Window.

This screen allows the user to enter upto 80 Channe! Frequencies. Any Channel can
be selected and in any order. Pressing the Up (T} and down (1) arrow keys moves
the current selector up and down respectively. To move to the first channel, press
<CTRL PageUp> while pressing <CTRL PageDown> moves to the last channel.
The current channe! is the one with the highlight on it. (in the Figure above, itis
Channel 0). To select a channel fo edit data for, either

» Press ENTER when the correct channel is highlighted

+ Double click the mouse on the channel.

When a channel is selected, the Program Channel Dialog Box is displayed. See the
Figure below. When entering data, only frequencies in the correct band may be
entered. For the data to be valid, a RX frequency must be entered.
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Figure 42. Program Channel Dialog Box.

The Program Channel Dialog Box is used to enter the RX and TX Frequencies for the
selected channel. It also allows the RX and TX Auxiliary data to be entered. The RX
and TX frequencies must be in the correct Band as selected with Band Code (see
Section 3.4.1) and madifier with Modifier Code (see Section 3.4.2).

The RX and TX Auxiliary Data can either be CTCSS Frequencies or CDCSS Codes.

For CDCSS Codes, negative values can be entered. These are entered with a minus
sign followed by the Code {eg -411)}.

Refer to CTCSS Frequencies and CDCSS Codes for possible values (Figure 43
below).

a4-3
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CTCSS Frequencies CDCSS Codes
Frequency | Frequency CDCSSs | CDCSS CDCSS CDCSSs
Code Code Code Code
0 Disabled 136.5 Hz 0 134 311 516
67.0 Hz 141.3 Hz 023 143 315 532
71.9Hz 146.2 Hz 025 152 331 546
74.4 Hz 151.4 Hz 026 155 343 565
77.0 Hz 156.7 Hz 031 156 346 606
79.7 Hz 162.2 Hz 032 162 351 612
82.5 Hz 167.9 Hz 043 165 364 624
85.4 Hz 173.8 Hz 047 172 365 627
88.5 Hz 179.9 Hz 051 174 371 631
91.5 Hz 186.2 Hz 054 205 411 632
94.8 Hz 192.8 Hz 065 223 412 654
97.4 Hz 203.5 Hz 071 226 413 662
100.0 Hz 210.7 Hz 072 243 423 664
103.5 Hz 218.1 Hz 073 244 431 703
107.2 Hz 225.7 Hz 074 245 432 712
110.9 Hz 233.6 Hz 114 251 445 723
114.8 Hz 241.8 Hz 115 261 464 731
118.8 Hz 250.3 Hz 116 263 465 732
123.0 Hz 125 265 466 734
127.3 Hz 131 271 503 743
131.8 Hz 132 306 506 54

Figure 43. Auxiliary Code List.

To enter an negative CDCSS Code, enter a minus sign followed
by the CDCSS Code. For example -365.

The Dialog box displays the current Channel Frequency number,

the RX and TX Frequency, RX and TX Auxiliary Data and four buttons.

These buttons are :

+ OK - exils and saves the selected channel to the channel group list.

» Cancel - exits and does nol save any data.

+ Next - save the selected channel to the channel group list and increments the
Channel Number by 1.

¢ Previous - saves the selected channel to the channel group list and decrements
the Channel Number by 1.
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When an incorrect RX frequency has been entered, the following error message is
displayed. A TX frequency error generates the same basic screen.

Figure 44. Incorrect RX frequency entered.

The same basic screen is displayed when an incorrect Auxiliary code is entered,
except in this cas the display reads “Incorrect RX Auxiliary Code” or “Incorrect TX
Auxiliary Code”.

4.4 Scan Window

The following figure shows the Scan A and B windows, which can be considered
equivalent.

Figure 45. Scan A and B Windows.

This screen allows the user to enter upto 64 Scan Channels for two groups. Scan
Channels can only be entered in order (from t onwards), otherwise ihe following error
message is displayed.

Figure 46. Accessing incorrect item.

Scan Channels can only contain channels that have been defined. That is, only
channels that have had a RX frequency defined for them in the Program Channel
window (see Section 4.3).

Both Scan groups can contain the same channels and each group
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can contain repeated channels.

The Scan Channels are entered in the Scan Channel Dialog Box.

Figure 47. Scan Channel Dialcg Box.

The Dialog box displays the current Scan Channel number, the channel to scan and

four buttons. These buttons are

¢ OK - exits and saves the selected channel to the scan group list.

+ Cancel - exits and does not save any data.

« Next - save the selected channel to the scan group list and increments the Scan
Number by 1.

+ Previous - saves the selected channel to the scan group list and decrements the
Scan Number by 1.

If an invalid channel is entered, the following message is displayed.

Figure 48. Incorrect Scan channel entered.
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5. SAMPLE DATA ENTRY

The following gives a demonstration of how to enter some data and then program an
EPROM.

The following is a description of what we want to enter.

EPROM Midland Mobile - Z 273

Model Number 5308 -

Serial Number 12345678

Customer Number 22417394AC

Date 27-10-94

Band 400 MHz

Modifier None

CH RX MHz RX-Aux TX MHz TX-Aux
01 406.3125 151.4 415.7625 072
02 406.8125 416.2625

03 407.3125 2181 416.7625 218.1
04 407.8125 311- 417.2625 79.7
05 406.5250 723 415.9750

06 407.0250 411- 416.4750 411-
08 407.5250 107.2 416.9750 156.7
09 408.0250 67.0 417.4750 165
Scan A

01 02 08

Scan B

o1 03 04 05 06

BCLO W/ALERT (2)

TX Total 90 sec (3)

INT A 25 msec (1)

INT B 300 msec (3)

Scan Hold Time RX 5 sec (2)

Scan Hold Time TX 2.5 sec (1)

PRI Mode 4/2 (2)

Scan Mode Modified/CTCSS/OPEN (7)

There are a number of steps that need to be performed in order to program an

. EPROM with this data. The following is a list of actions that need to be performed.
» Select EPROM type

Select Band

Setect Modifier Code

Enter Heading Data

Enter Function Codes

Enter Program Channels data

« Enter Scan Channels

* Save File
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» Blank Check EPROM
« Program EPROM

5.1 EPRCOM Type

The first step that needs to be performed is to set the EPROM type. This can be
achieved by selecting the EPROM Menu from the Menu bar and then selecting
EPROM | Type . This will list two possible choices, as shown in Figure 49. Select
the setting titled “"Midland Mobile Z-273", as shown below.

Figure 49. Select EPROM Type.

Press ENTER, press Alt O or click on OK to confirm your choice. This will set the
current EPROM type to the Midland Mobile Z-273 EPROM. This can be confirmed by
checking the EPROM type at the top of the screen. The screen should look like
Figure 3.

5.2 Band and Modifier Code

The next step to perform is to change the Band (and if necessary the Modifier Code).
Select the Channels window or Menu and then the Band item. The screen that is
displayed is shown in Figure 30. To change the Band to 400 Mhz select the “Band 3
(403 - 520 Mhz )" which then displays the following screen.

Figure 50. Band Selection Dialog Box after data entry.

Press ENTER, press Alt O or click on OK to confirm your choice. This will change the
Band to 400 Mhz which can be confirmed in the Channel window, as shown in Figure

51 below.
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Figure 51. Channel Window showing new Band.

As there is no Modifier code, there is nc need to change to enter the Modifier Dialog
box and change the Modifier Code.

Now that the EPROM type and the Band (and Modifier when necessary) have been
entered, the fotlowing steps can be performed in any order

+ Heading Data

« Function Codes

« Program Channels,

5.3 Heading Data
To enter the Heading Data, select the Options Window or Menu and sefect Heading.
This will display the screen as shown in Figure 38.

The cursor is currently set at the Model Number so start entering data from here,
Type “5308" for the Model Number and press TAB to jump to the next option and type
the Serial Number here. Continue on until all Heading data has been entered. The
Date field shows today's date when entering the data. To enter the given date, just
overwrite the old date. The screen would now look like this.

Figure 52. Heading Dialog Box after data entry.

When finished, press ENTER, press Alt O or click on OK. The data is now shown on
the screen as can be confirmed in the Options window, as shown in Figure 53 below.
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Figure 53. Options window after Heading Data Entered.

To enter the data, select the Function Cade's that are to be modified. First off, we will
edil the Function Codes 1.

When selected, Function Codes 1 displays a screen as shown in Figure 36. Enter the
following data

e BCLO With/ALERT (2)
o TXTotal 90 sec (3)

¢ INTA 25 msec (1)

« INTB 300 msec (3}

¢ Scan Hold Time RX 5 sec (2)

« Scan Hold Time TX 25sec (1)

and when completed the screen will ook like this.

5.4 Function Codes

The function Codes are also entered in the Options Window or Menu. There are two
parts to the Function Codes

Figure 54. Function Code 1 Dialog Box after data entry.

Press ENTER, press Alt O or click on OK to confirm your choice.
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Now we go to Function Code 2. When selected, Function Codes 2 displays a screen
as shown in Figure 37. Enter the fotlowing data

+ PRI Mode 4/2 (2)

» Scan Mode Modified/CTCSS/OPEN (7)

and when completed, the screen will look like this

Figure 55. Function Code 2 Dialog Box after data entry.

Press ENTER, press Alt O or click on OK to confirm your choice. Now that Function
Codes 1 and 2 have been entered, the Option window would look like Figure 56
betow.

Figure 56. Options Window after Heading and Function Codes 1 & 2 entered.

5.5 Program Channels

To program the RX and TX frequencies for the required channels, select the Program
Channels window. Once selected, maove the highlight up (or down) the list of
channels until the appropriate channel is reached. To then edit the values in this
channel, press ENTER. (An alternative method is to use the mouse and double click
on the channel that is to be edited). When selected, the Program Channet Dialog Box
is displayed, as in Figure 42, The next step is to enter the AX and TX frequencies

" {and Auxiliary values, if any).

For our example, select channel 1. Enter the RX frequency of 406.3125 and press
TAB or click on the next field. Here, enter the AX Auxiliary value of 151.4. At any
time, press F1 to get on-line help. The on-line help here gives a list of valid CTCSS
and CDCSS codes. Press TAB or click on TX Frequency field. Enter the TX
frequency of 415.7625 and press TAB or click an the TX Auxiliary field and enter
072 (CDCSS code). The Dialog box would now look like this.

el
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Figure 57. Program Channels Dialeg Box after Channel 1 Data Entered.

As the next channel to enter data for is 2, press Alt N for Next or click on it. This will
display the current values for channel 2. The alternative to this is to press ENTER,
Alt O or click on OK with the mouse to confirm the data and then move the highlight
to the next channel. Continue to enter the values for all necessary channels. When
they have been entered, the Program Channel window will look like this.

Figure 568. Program Window after all channel data entered.

5.6 Scan Channels

Now that the Channe! frequency data has been entered, we can enter the Scan
Channels. To do this, select the Scan A window, as in section 4.4. Scan channels
must start from Scan Channel 1 so select this channel. This displays Figure 47.

The first channel to enter is 01, so type this in. The screen would now look like this.

Figure 59. Scan A Dialog Box after Channel 1 Data Entered.

Press Alt N or click on Next to proceed to the next channel. Continue to enter the
Scan A channei data and then perform the same actions for the Scan B channels.
When finished, the Scan A and B windows would look like
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Figure 60. Scan Windows after all channel data entered.

All the relevant data has now been entered. The whole screen would like the

following.

Figure 61. Screen after all Data has been entered.

Now, to make sure that we do not lose this data, we will save it.

5.7 Save Data.

In order to save the data that has been entered, select the Save or Save As command
from the File Menu (see section 3.2.3 and 3.2.4). The screen which appears is shown
in Figure 11, Enter the name to call the file in which the data is to be stored (for
example Example.Dat). The screen would look like this.
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Figure 62. Save Data as file "Example.Dat".

Press ENTER, Alt O or click on OK with the mouse tc save the data. A message box
will be displayed showing that the data was saved. The file name is now shown in the
bottom right hand corner of the screen.

5.8 Blank Check

A blank check must be performed on the EPROM before it can be programmed. In
order to do this, switch OFF the MRP 70 - 1000C hardware programmer and insert the
EPROM. Once EPROM has been inserted, turn the MRP 70 - 1000C programmer
ON. The green light should come on.

Select Blank Check from the EPROM menu (see section 3.3.2) and Figure 17 should
be displayed. The MRP 70 - 1000C programming unit's red light is briefly displayed,
showing that the EPROM is being accessed. A message should then be displayed on
the screen. This would either be Figure 19, in which case the EPROM is Blank and is
ready lo be programmed, or else a Figure such as Figure 20 is displayed, showing an
error message that the EPROM is not Blank. In this case, the EPROM must be put
under an Ultra Violet light to erase its contents.

5.9 Program EPROM

The final step to perform is to program the data into the EPROM. This is performed
by selecting the Program option from the EPROM menu. This will display Figure 22.
The Red light on the MRP 70 - 1000C programmer will come on while programming is
in action.

On completion of programming the EPROM, Figure 23 will be displayed. An easier
way in which to perform the Blank check and then Programming is to use the Auto

command. This will perform the Blank check and, if that passes, the Programming
step.

The EPROM has now been programmed with the data specified. To check that the
right data has been programmed correctly, a Read can be performed.
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5.10 Read EPROM

Selecting Read from the EPROM menu displays Figure 24. Type in a name to save
the data that is Read from the EPROM. Once a name has been entered, Figure 25
will be displayed. The red light on the MRP 70 - 1000C programmer will turn on,
showing that the EPROM is being Read. When the Read has been completed, the
screen is updated to show the dala that was Read in and should lock like the Figure
below.

&

Figure 63. Screen after Read has been performed.

The example has now been completed. The EPROM is now ready to be inserted into
the mobile unit, ready for use.
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6. APPENDIX A - RT 85 Mobile.

This Appendix deals with the AWA RT-85 Mobile EPROM. Support for this EPROM
is only for the Australian market, in which case the program execution file will be
called MRP70A.EXE (see section 1.2 for distribution files} .

Although there are a number of similarities between the RT-85 and Z-273 EPROMS,
there are some differences. .

» Normal Options Unavailable - Special RT-85 Options instead

s Only Certain Bands and Modifiers allowed

No Centre Frequencies

Auxiliary Numbers are in different format

Only Scan A channels can be entered - maximum of 31 channels

To change the EPROM type to RT-85, see section 3.3.1. When the RT-85 EPROM
has been selected, the following screen will be displayed.

Figure 64. Main screen after EPROM changed to RT-85.

The name of the EPROM can be seen in the Menu Line as AWA Mobile-R85. The
following sections details the differences between the RT-85 and the Z-273 EPROMS.

6.1 RT 85 Options Menu
Figure 65 below shows the coptions available in the Options Menu item when RT-85
has been selected.
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Figure 65. RT-85 OPTIONS Menu Item selection.

The RT 85 Options are cnly available when the AWA RT-85 Mobile EFROM is
selected. Otherwise, the user cannot select these options. The other options
(Heading Input and Function Codes) are not available when the AWA RT 85 EPROM

is selected.

The Options Menu item contains the following options
+ RT 85 Options

o TX Carrier

e Scan Interval.

6.1.1 RT 85 Options
The RT 85 Options screen looks like

g £ 4 o

Figure 66. RT 85 Options Dialog Box.

The RT 85 Options screen allows the user to select a number of options that effect
the use of the radio.

These options are :
+ CTCSS Unit

¢ Busy Lamp Delay
* Sel - Call Unit
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« Siatus Control Function
e Busy TX Inhibit

s Silent TX Inhibit

« Silent SW Inhibit

To select an option either use the mouse and click on the setting(s), or use the arrow
keys to go up/down the list and press space bar to select. More than one option can
be selected. When an option is selected, a cross appears nexl to the options name.

6.1.2 TX Carrier
The RT 85 TX Carrier Dialog Box consists a number of settings.

Figure 67. RT 85 TX Carrier Dialog Box.

To select an option either use the mouse and click on the setting(s), or use the arrow
keys to go up/down the list and press space bar to select. Press TAB to jump from
ane Box to anather or the Letter above the box that is highlighted.

Selecting a different setting for an option maves the highlight to the new setting. Oniy

one setting can be selecled for each option.

6.1.3 RT 85 Scan Interval
When selecting this option, the following figure is displayed.

Figure 68. RT 85 Scan Interval Dialog Box.
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The RT 85 Scan Interval screen allows the user to select the Scan Interval, Scan Hold
Timer and the Scan Hold Condition.

To select an option either use the mouse and click on the setting(s), or use the arrow
keys to go up/down the list and press space bar to select. Press TAB to jump from
one Box to another or the Letter above the box that is highlighted.

Selecting a different setting for an option moves the highlight to the new setting. Only
one setting can be selected for each optioh.

6.2 CHANNELS MENU

The same options are avaijlable for the RT-85 EPROM as the Z-273 EPROM except
that the Center Frequency is never avaitable. There some differences in the Band
and Mcdifier options, which are discussed below.

6.2.1 BAND
When the Band menu item is selected, the following screen is displayed.

Figure 69. RT-85 Bands available.

As can be seen, there are only three bands available. They are
¢ Band 1 60-90 Mhz

¢ Band?2 136-174 Mhz

¢ Band 3 403 - 520 Mhz.

6.2.2 MODIFIER

The Modifiers used for each Band are also different. In the case of Band 3, there are
the following Madifier Codes available.
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Figure 70. RT 85 Modifier Codes for Band 3.

As Figure 70 above shows, there are only four Modifier Codes available when Band 3
has been chosen.

6.2.3 CENTER FREQUENCY

When the EPROM type has been set to RT-85, Center Frequency values are not
avaifable. When the user tries to select this option, the following screen is displayed .

Figure 71. Message When Selecting Unavailable Option.

This message will also appear when the user tries to select any option that is not
supported by the current EPROM. This includes the Heading input and Function
Codes from the OPTIONS Menu,

6.3 PROGRAMMING CHANNELS

The Programming Channels window is the same as used for other EPROMS (see

Section 4.3). The only difference is in the way that Auxiliary values are used. While,

with other EPROMS, either CDCSS or CTCSS could be entered, for the RT-85, only

CDCSS codes can be entered, and these range from 0 (none) to 31. Figure 72 below
shows an example Programming Channels screen with Auxiliary values.
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Figure 72, RT-85 Programming Channels Screen with Auxiliary Values.

When entering an invalid Auxiliary number of an invalid frequency, the same screen
as shown in Figure 47 is displayed.

6.4 SCAN CHANNELS

Entering channels in the Scan Channels window is exactly the same as discussed in
Section 4.4. The only difference with the RT-85 EPROM is that only the SCAN A
window is available. [f the user tries to select SCAN B, then the error message as
shown in Figure 71 is displayed.

Within the SCAN A window, only 31 of the Scan Channels can be programmed. If the

user tries to access a Scan Channel higher than that, an error message will be
displayed.
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